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IMPORTANT

By downloading this Software, you agree to be bound by the following Software License Agreement.

SOFTWARE LICENSE AGREEMENT

This is a binding agreement between OMRON Corporation ("OMRON") and you (the "User") on the 
terms and conditions of the license of the Software.

1. In this Agreement, "Software" means the computer program and related documentation put on the 
website linked to button below. The "Software" shall include any derivative works thereto. Copyright of 
the Software remains the sole property of OMRON or the third party who has licensed the Software to 
OMRON and shall not be assigned to the User under this Agreement.

2. OMRON grants the User a non-exclusive, non-transferable and limited license to use the Software 
on computers owned by the User per license. The User shall not simultaneously use the Software on 
more than one computer per license.

3. The User shall not sub-license, assign nor lease the Software to any third party without prior written 
consent of OMRON.

4. The User may copy the Software for back-up purpose only. The User may not de-compile, 
de-assemble, reverse engineer nor otherwise attempt to discern the source code of the Software.

5. The User shall treat any information contained in the Software as confidential and shall not disclose 
it to any third party. This obligation shall survive the termination of this Agreement.

6. THERE ARE NO WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO, 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR PARTICULAR PURPOSE. IN NO EVENT, 
OMRON WILL BE LIABLE FOR ANY LOST PROFITS OR OTHER DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THIS AGREEMENT OR USE OF 
THE SOFTWARE.

7. If the User breaches this Agreement, OMRON may terminate this Agreement upon notice to the 
User. In that event, the User shall return the Software and all copies thereof.

8. Neither this Agreement nor any party or portion hereof shall be assigned, sub-licensed or otherwise 
transferred by the User. Should any provision of this Agreement be held to be void, invalid, unenforce-
able or illegal by a court, the validity and enforceability of the other provisions of this Agreement shall 
not be affected thereby. Failure of a party to enforce any provision of this Agreement shall not consti-
tute or be construed as a waiver of such provision or of the right to enforce such provision.

9. This Agreement shall be governed by and construed under the laws of Japan. Any and all dispute, 
controversy or difference which may arise between the parties hereto out of or in relation to or in con-
nection with this Agreement shall be finally settled by arbitration in Osaka, Japan in accordance with 
the Arbitration Rules of the Japan Commercial Arbitration Association. The award rendered by arbitra-
tor(s) shall be final binding upon the parties hereto.
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Safety Precautions

The following notation is used in this manual to provide precautions required to ensure safe usage of
the Wireless Switch Support Tool and A2W Wireless Pushbutton Switch.
The safety precautions that are provided are extremely important to safety. Always read and heed the
information provided in all safety precautions.

Definition of Precautionary Information

Symbols

The triangle symbol indicates precautions (including warnings).
The specific operation is shown in the triangle and explained in
text.
This example indicates a general precaution.

The triangle symbol indicates precautions (including warnings).
The specific operation is shown in the triangle and explained in
text.
This example indicates a precaution for electric shock.

Indicates non-specific general prohibitions.
The specific operation is shown in the circle and explained in
text.
This example indicates a disassembly prohibition.

The filled circle symbol indicates operations that you must do.
The specific operation is shown in the circle and explained in
text.
This example shows a general precaution for something that you
must do.

Caution
Indicates a potentially hazardous situation which, if not avoided, may 
result in minor or moderate injury, or property damage.
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Do not use this product without a protection circuit. Otherwise it may result in
heavy injuries or damage on life or property due to malfunction.
Dual or triple safety protection circuits, such as emergency stop, interlock, or limit
circuit, must be configured by external control circuit so that the system should
operate on safe side even if a failure of this product or an error due to an external
factor occurred.

This product is used radio waves for communications, communications may be
interrupted. Even in that case, consider the system to be safe.

Do not use this product close to any medical equipment such as a pacemaker as
it may affect operation of such medical equipment and may result in heavy
injuries.

Caution



   Precautions for Safe Use

4 Wireless Pushbutton Switch User’s Manual (A276)

Precautions for Safe Use

Do not use this product near a device that may function abnormally due to the radio waves emitted by
this product.

Precautions for Correct Use

• Refer to the Wireless Pushbutton Switch A2W User's Manual (Man. No. A265) and the operation
manual supplied with the Master Unit.

• You will have to make the settings during installation or replacement. Make the settings correctly
according to the manual, perform the communications test in advance, and make sure that the
system operates normally before using it.

• The use of this product at other than the designated frequency is prohibited by the Radio Law. Use
this product after confirming the frequency and product type according to the country of use.

• If the cable is disconnected during setup, be sure to reconfirm the setting contents. Be careful not to
remove the cable during setting.

• Do not connect or disconnect the USB-Serial Conversion Cable while communications are in
progress. Product faults or malfunction may occur.

• Connect the cable to the back of the setting tool port so that the cable does not come off during use.
• Use the specified USB - Serial Conversion Cable. Also, if you extend the USB part with an extension

cable and use it, it may not be able to communicate properly due to noise or other effects.
• Do not bend the cable past its natural bending radius, or pull on the cable with under force. Doing so

may cause the wire disconnection.
• If you register a Slave button to the Master Unit in an environment where another wireless

pushbutton switch system is operating around it, it can be erroneously set. Therefore, when
registering a Slave button, perform in an environment where the system of another wireless
pushbutton switch is not operated.

• Install this product at a location where there is an unobstructed view between the wireless push
buttons and the Master Unit.

• Do not mount the antenna at a location surrounded by metal, such as inside the panel.
• The Radio Law prohibits connecting an antenna other than that designated. Never change the

antenna.
• Mount the antenna while ensuring that it is not parallel with the wiring or metal plate. Also, ensure a

safe distance from the wiring and metal plate.
• When mounting the designated antenna with magnet, do not install the antenna cable together with

the power line or electric cables. Also, do not forcefully pull or bend the cable, or keep any object on
top.

• Do not pull or grab the antenna while carrying or handling the product.
• To ensure the antenna does not come off during operation, attach it right into the connector.
• Do not use the product under the following locations:

• Locations where the product may come into contact with water, oil, or chemicals.

• Locations subject to static electricity, excessive noise, or electric fields.

• Where the influence of vibration and shock is large.

• Locations where large amounts of dust or dirt are present.

• Storage of this product must be within the specified environment. Allow the product to warm up to
room temperature for at least 3 hours after it has been stored at -10°C or lower.
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• Do not allow any pieces of metal or conductors or any clippings or cuttings resulting from installation
work to enter the Product.

• Do not use this product at a location with an extremely high humidity, or near a television or radio, or
an object from which sparks may fly out such as a motor or drill, or even near fluorescent lighting.

• Always turn OFF the power before replacing the wiring or devices.
• Do not handle with wet hands.
• Be aware that if you operate the mode settings switch of the actual Master Unit while selecting the

Display the received SB ID Check Box from the Wireless Switch Support Tool, a communication error
occurs.

• Be aware that the set time, displayed by checking "ON" in the ON time of MU output under the View
Menu, is registered in Master Unit, even when you click the Register to MU Button without ON time
of MU output displayed below the Slave button registration and output assignment table,

• Be aware that if you operate the mode setting switch of the actual Master Unit while measuring the
wireless communications environment from the Wireless Switch Support Tool, a communications
error will occur.

• The communication test checks the Master Unit periodically for the latest received data from the
Wireless Switch Support Tool and displays the latest received data from the Slave button if it is
available. However, if the Master Unit receives the operation result of the Slave button at intervals
shorter than the interval to be periodically acquired, the value is overwritten before the Wireless
Switch Support Tool retrieves the reception result. As a result, be aware that the reception result from
the Slave button may be missed.

• During the communications test from the Wireless Switch Support Tool, do not open a tab-delimited
text file (.txt) of the reception result log until you click the Start Button and click the Complete Button.
If you open it, you cannot write the result to a file when receiving data, so you cannot implement
Wireless Test correctly.

• Be aware that if you operate the mode setting switch of the actual Master Unit while measuring the
wireless communications environment from the Wireless Switch Support Tool, a communications
error will occur.

• Set the font size on your computer screen to 100% (default). Wireless Switch Support Tool display
screen may not be displayed correctly if it is set to expand.
For details on how to set the character size of your computer, refer to the manual of your Windows.
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Revision History

A manual revision code appears as a suffix to the catalog number on the front and back covers of the
manual.

Related Documents

For details on the USB-Serial Conversion Cable, refer to the Instruction Manual that is provided with the
product. 

Revision code Date Revised content
A April 2018 Original production

A276-E1-01
Revision 
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1-1 Overview

Wireless Switch Support Tool is a host tool for the A2W wireless pushbutton switches system.

This tool enables you to set up the Master Unit and check and monitor the environment to be used as 
follows.

• Checks and changes the status of Slave button registration and output assignment settings in Master 
Unit ,or sets them newly

• Set output one-shot time of the Master Unit

• Estimate the radio field strength around the Master Unit (ED scan)

• Executing Wireless Test, and displaying reception result logs thereby with saving tab-delimited text 
file

• Displaying Master Unit's current operation mode and operating time

Connect the computer (Wireless Switch Support Tool) one-on-one to the Master Unit using the USB - 
Serial Conversion Cable (E58 -CIFQ2) with the conversion cable (E58-CIFQ2-E).

Connect to the front "PC CONN" port of Master Unit.

Note Install the driver for USB to serial conversion cable to computer before using USB to serial conversion cable 
with the conversion cable.

1-1-1 What is the Wireless Switch Support Tool?

1-1-2 Connection Configuration

Wireless Switch Support Tool 

Wireless communications 

· Master Unit Settings
· Confirmation and monitoring of Master 
Unit status

USB - Serial Conversion Cable (E58 
-CIFQ2) with the conversion cable 
(E58-CIFQ2-E) (Order Separately)

A2W-T□-WC1 Slave button

PC CONN port

A2W-R□□-WC1 Master Unit
(24 VDC power supply required)
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Content of file created by Wireless Switch Support Tool
 

1-1-3 Wireless Switch Support Tool Functions and Specifications

Item Description

Target device
Wireless pushbutton switch

A2W-R□□-WC1 Master Unit

Project registration unit One Master Unit per project

Master 
Unit Set-
tings

Slave but-
tons regis-
tration and 
output 
assignment 
settings

Slave buttons 
registration and 
output assign-
ment settings

Slave button ID 
setting

Manual input, or acquiring the ID value by actually 
operating the Slave button

Output Assign-
ment Setting

Check specification

Confirmation of 
current setting 
state of the Slave 
buttons registra-
tion and output 
assignment set-
tings

Monitor Slave 
button ID

Displayed in Slave button ID Column

Monitoring the 
output assign-
ment

Color display

Saving to or reading from a setup file 
(tab-delimited text file)

Supported.

Set output one-shot time of the Master Unit 50 to 1000 ms (default 500 ms)

Confirm 
and moni-
tor the 
operating 
environ-
ment

Survey of radio field strength around Master Unit 
(ED scan)

Starting method: button operation

Result: peak value (PK) of reception strength, average 
value (AV) of reception strength

Wireless communi-
cations test

Display reception result

Starting method: Start Button operation 

Result: Log display of the following reception result 
from Slave buttons

Contents: Time, Slave button ID, and Receive radio 
field strength

Number of indicators: Maximum 100

Save tab-delimited text file 
of received result

Starting method: Start Button operation 

Result: logs of the reception result (for each operation 
of the Start Button) are saved in a tab-delimited text 
file 

Status confirmation
Confirm operating mode RUN mode, TEST mode, ID mode, Master Unit error

Confirm operating time 0 to 99,990 hours (in units of 10 hours)

Operation

Software reset of Master 
Unit

Restore the operating mode of the Master Unit to the 
front mode settings switch state

Reset to factory default
Reset the Master Unit to factory default (possible only 
when the Master Unit error LED is lit in red)

File type File name
Exten-
sion

Contents Default save location

Setup file User specified

Default: WirelessSwitchSupportTool_-
SettingFile_jp or WirelessSwitchSup-
portTool_SettingFile_en

Note The file name will be changed 
according to the language speci-
fied during installation.

.txt Tab-delimited text file includ-
ing the following

• Slave buttons registration 
and output assignment set-
tings

• Setting of one-shot output 
time of Master Unit

C:\OMRON\Wireless 
Switch Support 
Tool\DATA

Wireless test 
results file

Time stamp (yyyymmddhhmmss) .wire-
lesstes

.txt Tab-delimited text file including 
the following

• Reception time 

• Slave button ID 

• Received field strength

C:\OMRON\Wireless 
Switch Support 
Tool\DATA

ED scan 
result file

Time stamp (yyyymmddhhmmss) 
.edscan

.txt Tab-delimited text file includ-
ing the following

• ED scan detailed result

C:\OMRON\Wireless 
Switch Support 
Tool\DATA
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Precautions for Correct Use

Set the font size on your computer screen to 100% (default). Wireless Switch Support Tool dis-
play screen may not be displayed correctly if it is set to expand.

For details on how to set the character size of your computer, refer to the manual of your Win-
dows.

1-1-4 Operating environment of Wireless Switch Support Tool

Function Name Description

OS Windows 10 (32 bit / 64 bit)

Windows 8.1 (32 bit / 64 bit)

Windows 7 (32 bit / 64 bit)

CPU 1 GHz or more, 32 bit or 64 bit processor

Memory 1 GB or more, or 2 GB or more (in the case of 64 bits)

Disk reserved area 
capacity

16 GB or more, or 20 GB or more (in the case of 64 bits)

Monitor resolution 1024 × 768 (XGA), High Color 16 bits or more

.NET .NET Framework 4 (Install if not installed)

Language Japanese, English

Communications port Communications port USB (USB 2.0 compatible)

Applicable cable USB - Serial Conversion Cable (E58-CIFQ2) with the conversion cable (E58-CIFQ2-E)

Communications 
driver to use

Driver for E58 (USB - Serial Conversion Cable, USB - infrared conversion cable)

(Note: Hereafter, it is abbreviated as "Driver for USB-Serial Conversion Cable").
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2-1 Basic procedures

 

Procedures

(Installation and 
Wiring)

Install and wire the A2W Wireless pushbut-
ton switch system

↓

Download the driver for the USB-Serial 
Conversion Cable and the Wireless Switch 
Support Tool together

↓

Install the driver for the USB-Serial Conver-
sion Cable and the Wireless Switch Sup-
port Tool together

↓

Connect this tool to the Master Unit using 
USB to serial conversion cable with the 
conversion cable

↓

Start Wireless Switch Support Tool

↓

New use Already use

Set the registration and output assignment 
of the Slave buttons

Confirm the current setting status of the registra-
tion and output assignment of Slave buttons

↓

Change the registration and output assignment 
settings of Slave buttons

↓

(If necessary) Set the one-shot output time of the Master Unit

↓

Transfer the settings to the Master Unit

↓

Estimate the radio field strength around the Master Unit (ED scan)

↓

Wireless Test

↓

Switch the mode settings switch of the Master Unit to RUN Button.

Procedures .1
Setup of 
this tool

Procedures .2

Procedures .3

Master Unit 
settings

Confirmation 
and 
monitoring 
of the 
Master Unit 
status
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3-1 Screen transition

The screen transition after starting Wireless Switch Support Tool is as follows.

Startup screen

Slave buttons registration and output 
assignment settings screen

Confirm the status screen

Wireless test screen

Other operation screen

COM port connection screen

Set Master Unit and confirm screen

Noise check of the set frequency 
(ED scan)
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4-1 Setup of this tool

The following work is necessary only when using this tool for the first time.
 

 

When using E58-CIFQ2, install the driver separately for each USB port.

Note The E58-CIFQ2 will be assigned a COM port number for each USB port of the personal computer.

 Introduction

1 Prepare the USB - serial conversion cable (E58-CIFQ2 + conversion cable (E58-CIFQ2-E)).

2 When the USB - serial conversion cable (E58-CIFQ2) is connected to the personal computer, 
the operating system will detect the E58-CIFQ2 as a new device. Install the driver according to 
the prompts
from the installation wizard. Use the following specific procedure for each OS.

 Using Windows 8.1 or 10

1 Connect the USB-Serial Conversion Cable to the USB port on the personal computer, and 
right-click the Windows Start Button to start the Device Manager.

Note If using keyboard, the menu is displayed by pressing X key while holding down Windows key.

Step 1 Download the driver for the USB-Serial Conversion Cable and the 
Wireless Switch Support Tool together.

Download both the USB - serial conversion cable driver and Wireless Switch Support Tool from 
OMRON website:  (http://www.ia.omron.com/), and unzip it to a desktop or the like.

Step 2 Install the driver for the USB-Serial Conversion Cable and the 
Wireless Switch Support Tool together.

Install the driver to enable using the E58-CIFQ2 USB-Serial Conver-
sion Cable with the personal computer.

Procedure
Master Unit settings

Procedure 1.
Setup of this tool

Step 1
Download the driver for the USB-Serial Conversion 
Cable and the Wireless Switch Support Tool 
together.

Step 2
Install the driver for the USB-Serial 
Conversion Cable and the Wireless 
Switch Support Tool together.

2. Procedure3.
Confirmation and monitoring 
of the Master Unit status

Procedure4.
Maintenance operation
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2 Right-click E58-CIFQ2 in Other Devices and select Update Driver Software.

3 In the Update Driver Software Dialog Box, select Browse my computer for driver software 
Option.

4 Click the Browse Button, select the downloaded driver, and then click the Next Button.
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5 The Windows Security Dialog Box will be displayed. Click the Install Button.

6 When a message in the Update Driver Software Dialog Box says Windows has successfully 
updated your driver software, click the Close Button.

7 Right-click USB Serial Port in Other Devices in the Device Manager Dialog Box and select 
Update Driver Software.
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8 In the Update Driver Software Dialog Box, select Browse my computer for driver software 
Option.

9 Click the Browse Button, select the downloaded driver, and then click the Next Button.

10 The Windows Security Dialog Box will be displayed. Click the Install Button.
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11 When a message in the Update Driver Software Dialog Box says Windows has successfully 
updated your driver software, click the Close Button.

12When the installation is finished, a COM port number will be allocated automatically.

To see that COM port number has been allocated, use the following procedure.

(1) Right-click the Windows Start Button to start the Device Manager.

(2) For example, if OMRON E58-CIFQ2 USB Serial Port (COM5) is displayed under the "Ports 
(COM & LPT)" heading in the directory tree, the device is assigned to COM port 5.

(Example)
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 Using Windows 7

1 Connect the USB-Serial Conversion Cable to the USB port on the personal computer, click This 
PC or Computer - System Properties from the Windows Start Menu to start up the Device Man-
ager.

2 Right-click E58-CIFQ2 in Other Devices and select Update Driver Software.

3 In the Update Driver Software Dialog Box, select Browse my computer for driver software 
Option.

4 Click the Browse Button, select the downloaded driver, and then click the Next Button.

5 The Windows Security Dialog Box will be displayed. Click the Install Button.

6 When a message in the Update Driver Software Dialog Box says Windows has successfully 
updated your driver software, click the Close Button. Click the Next Button.

7 Right-click USB Serial Port in Other Devices in the Device Manager Dialog Box and select 
Update Driver Software.

8 In the Update Driver Software Dialog Box, select Browse my computer for driver software 
Option.

9 Click the Browse Button, select the downloaded driver, and then click the Next Button.

10 The Windows Security Dialog Box will be displayed. Click the Install Button.

11 When a message in the Update Driver Software Dialog Box says Windows has successfully 
updated your driver software, click the Close Button.

12When the installation is finished, a COM port number will be allocated automatically.

To see that COM port number has been allocated, use the following procedure.

(1) Select This PC or Computer - System Properties from the Windows Start Menu to start up 
the Device Manager.

(2) For example, if OMRON E58-CIFQ2 USB Serial Port (COM5) is displayed under the "Ports 
(COM & LPT)" heading in the directory tree, the device is assigned to COM port 5.

(Example)
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1 Select setup.exe of the downloaded Wireless Switch Support Tool.

The following dialog box is displayed. Select Japanese or English Option, and then click OK 
Button.

2 Install the .Net Framework 4.0.

If .NET Framework is not installed on the computer, the .NET Framework Installation Dialog Box 
is started.

If the .NET Framework is already installed, the above Dialog Box is not displayed. (Normally, 
computer with Windows 8.1 or 10 OS, the above Dialog Box is not displayed.)

3 The following dialog box is displayed. Click the Next Button.

4 The License Agreement Dialog Box is displayed.

Read the License Agreement carefully. If you agree to all of the conditions, select the I accept 
the terms of the license agreement Option, and then click the Next Button.

Install the Wireless Switch Support Tool.
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5 The Select Project Folder Dialog Box is displayed. Check the installation folder, and then click 
the Next Button.

6 The Ready to Install the Program Dialog Box is displayed. Click the Install Button.

Installation of Wireless Switch Support Tool starts.

7 The Uninstall Complete Dialog Box is displayed. Click the Finish Button.

This completes the installation of the Wireless Switch Support Tool.
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Use the following procedure to uninstall the Wireless Switch Support Tool.

1 You use Add or Remove Programs in the Control Panel.

The Add/Remove Applications Dialog Box will be displayed.

2 Select Wireless Switch Support Tool and click Uninstall Button.

The following dialog box is displayed to confirm uninstallation of Wireless Switch Support Tool.

3 Click the Yes Button.

A dialog box is displayed after uninstallation is completed.

4 Click the Finish Button.

1 Insert the E58-CIFQ2 USB-Serial Conversion Cable into the USB port of the personal computer.

2 Start up Device Manager.

3 Right-click the OMRON E58-CIFQ2 USB Serial Port (COM) under the Ports (COM & LPT), 
and select Uninstall.

4 The Confirm Device Uninstall Dialog Box will start. Select Delete the driver software for this 
device, and click the OK Button.

Uninstalling the Wireless Switch Support Tool

Uninstalling the driver for the USB-Serial Conversion Cable
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5-1 Master Unit Settings

 

 

 

Select OMRON - Wireless Switch Support Tool from the Windows Start Menu.

The following COM port connection screen is displayed.

Select OMRON E58-CIFQ2 USB Serial Port (COM□) from the selection box of Serial Port and click the 
Run Button.

The following startup screen will be displayed.

Step 1 Connection with Master Unit with USB to serial conversion cable 
with the conversion cable

Step 2 Start this tool

Procedure
Master Unit settings

Procedure 1.
Setup of this tool

Step 1
Connection with Master Unit with 
USB to serial conversion cable 
with the conversion cable

Step 3
Slave button registration and 
output assignment settings

Step 4
Register the settings in the Master Unit, 
save the setup file as required.

Start this tool

Step 2

2. Procedure3.
Confirmation and monitoring 
of the Master Unit status

Procedure4.
Maintenance operation

Wireless Switch 
Support Tool

A2W-R□□-WC1 
Master Unit USB - Serial Conversion Cable 

(E58 -CIFQ2) with the conversion cable 
(E58-CIFQ2-E) (Order separatry)

Connect to the 
PC CONN port
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Click Set Master Unit and confirm Button on the Startup screen.

 Click Slave button (SB) ID and output No. ON time of Master Unit (MU) output Button below.

The following Slave buttons registration and output assignment settings screen is displayed.

Step 3 Slave button registration and output assignment settings

Slave button registration and 
output assignment table

Slave button ID acquisition table
Note: This is displayed if Received SB 
ID under the View Menu is select to ON 
(default: ON).
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• Menu list
 

 Confirm the current setting status of the registration and output assignment 
of Slave buttons

1 to 8 of SB No. are the management number of the Slave button in this table.

The current Slave button ID is displayed in the lower row PV (pink background) of the Slave button 
ID Column on each row of the Slave button.

Set the Slave button ID to the upper ”SV” (white background).

Main Menu Sub Menu contents

File Reading the setup file Reads file configuration file Read out the saved setup file.

Note If the format of the read file is incorrect, an error will be dis-
played.

Save as the setup file Saves the following information as a setup file.

• Slave buttons registration and output assignment settings

• Setting of one-shot output time of Master Unit

• Master Unit number, Master Unit name, and Slave button name

View ON time of MU output Switches whether or not to display ON 
time of MU.

ON: Displayed

OFF: No display (default)

Note Once OFF and then ON again, 
the status of the input field just 
before turning OFF is displayed.

Note Once you click the 
Back Button and 
display this screen 
again, the display 
items just before 
clicking the Back 
Button will be dis-
played. At that 
time, the display 
content is default.

Name Switches whether or not to display Master 
Unit number, Master Unit name, and 
Slave button name.

ON: Displayed

OFF: No display (default)

Note Once OFF and then ON again, 
the status of the input field just 
before turning OFF is displayed.

Received SB ID Switches whether or not to display the 
Received SB ID acquisition table.

ON: Displayed (default)

OFF: No indication

Note Once turned OFF and ON again, 
the received Slave button ID and 
Slave button number will be 
cleared.

Note Once you click the 
Back Button and 
display this screen 
again, the 
Received SB ID 
and Slave button 
number will be 
cleared.

Management number of the Slave button in the table

Slave button ID to set

Current Slave button ID
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 Slave button ID setting of each Slave button

Set the Slave button ID in the upper row of the Slave button ID Column in each row of the Slave button.
It depends on one of the following methods a) and b).
a) Manually enter the Slave button ID directly in the Slave button registration and output assign-

ment table. Enter the Slave button ID with 7 digits without omitting 0 (Example: "1" instead of 
"0000001").

Or
b) Actually operate the pushbutton on the Slave button, and then you can acquire the Slave button 

ID and input it. It depends on the following procedure.

1 Select the Display the received SB ID Check Box above the receive Slave button ID acquisition 
table.

2 Press the pushbutton on the Save button. The ID of that Slave button is acquired and displayed 
in the Received SB ID Field of the received Slave button ID acquisition table.
You can get the ID of up to eight Slave buttons.
* In the Received SB ID Field, the IDs of the Slave buttons that transmitted the signal to the 

Master Unit are acquired. If you do not enter the number in the SB No. Field, up to 8 IDs are 
displayed from the latest acquisition information.

* When the same Slave button is transmitted multiple times, the same ID is acquired more than 
once.

3 Register the acquired Slave button ID in the left table by any of the following methods.
• Method 1: button operation

In the Slave button Number (1 to 8) Field, enter the Slave button management number (in the 
Slave button registration and output assignment table) of the acquired Slave button ID. Then 
click the Input the SB ID Button on the received Slave button ID acquisition table. The 
acquired Slave button ID is set in the Received SB ID Column of the specified Slave button 
number in the Slave button registration and output assignment table.
* When you operate the Slave button with full eight IDs displayed, the value is deleted from 

the older information in the lines where numbers have not been entered in the SB No. Field. 
On the other hand, the value is not deleted in the lines where numbers have been entered 
in the SB No. Field.

* When you click the Input the SB ID Button under the following conditions, an error will be 
detected and displayed.
- A state where a Slave button number other than 1 to 8 is entered
- A state where duplicate Slave button numbers are entered
- A state where different Slave button numbers are entered for the same Slave button ID
- A state where the same Slave button ID already exists in the Slave button ID column (SB 

ID Column)

Directly enter the Slave button ID.
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• Method 2: Drag & drop operation

Drag and drop the acquired Slave button ID to 1 to 8 of SB No. in the Slave button registration 
and output assignment table.

In method 1, the following confirmation screen is displayed. If it is correct, click the OK Button.

Precautions for Correct Use

In the Received SB ID Field of the Slave button ID acquisition table, the same Slave button ID 
may be displayed according to the number of times the same Slave button was operated. Up to 
8 IDs can be displayed in the SB No. Field. When you operate the Slave button with full eight 
IDs displayed, the value is deleted from the older information in the lines where numbers have 
not been entered in the SB No. Field. On the other hand, the value is not deleted in the lines 
where numbers have been entered in the SB No. Field.

Or

1) Select the Check Box.
2) Acquire the ID value by 

actually operating the 
Slave button.

Push operation

3) Method 1: Button operation. 
1. Enter Slave button 
 Number. 

Example: 3

2. Click Input the SB ID 
Button

3) Method 2: Dragging
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 Assignment of each Slave Button to the Master Unit Output Number

The assignment setting to the current output number which has been read from the Master Unit is 
displayed with a pink background.

When changing or adding, select the Check Boxes on the right outputs 1 to 8. Multiple selects are 
possible.

Precautions for Correct Use

If you operate the mode settings switch of the actual Master Unit while selecting the Display the 
received SB ID Check Box from the Wireless Switch Support Tool, a communication error 
occurs. Then the following confirmation screen as to whether or not to continue the operation 
will be displayed, as the mode change was detected.

Additional Information

When selecting each item under the View Menu, each item is displayed and it becomes possi-
ble to input.

 Setting of Master Unit number and Master Unit name and Slave button name 
(as necessary)

When selecting Name under the View Menu, Master Unit number and Master Unit name will be dis-
played above the Slave button registration and output assignment table, Slave button name is dis-
played on the right.

• Enter Master Unit number in MU No. 1-9999 above the Slave button registration and output 
assignment table. This value is the management number of the Master Unit by the user.

• Enter any name of Master Unit in Name above Slave button registration and output assignment 
table.

Note The Master Unit number and name entered here becomes the default name of the setup file created by 
clicking Save as the setup file from the File Menu. (The default displayed name of setup file when saved 
is [Master Unit Number]_[Master Unit Name].)
However, this Master Unit Number and name will not be registered in the actual Master Unit, depending 
on the registration operation to the Master Unit with the setting shown in Step 4. This is the value on the 
Wireless Switch Support Tool. Therefore, we recommend that it be the same as the number or name 
written on the seal stuck to the actual Master Unit.

• Enter any name of the Slave button in Name to the right of the Slave button registration and out-
put assignment table.

It is displayed only when selecting the Name under the View Menu to ON.

It is displayed only when selecting the ON time of MU output 
under the View Menu to ON.
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 Setting of one-shot output time of Master Unit (as necessary)

When selecting ON time of MU output under the View Menu, ON time of MU output under the Slave 
button registration and output assignment table is displayed.

One shot output time setting of the current Master Unit read from the Master Unit is displayed in PV 
with a pink background.

If necessary, change SV of one-shot output time of the Master Unit from default 500 ms.

Set the setting value of ON time of Master Unit (MU) output. It can be set in the range of 50 to 1000 
ms.

Precautions for Correct Use

Be aware that the set time, displayed by checking "ON" in the ON time of MU output under the 
View Menu, is registered in Master Unit, even when you click the Register to MU Button with-
out ON time of MU output displayed below the Slave button registration and output assignment 
table.

Input an one-shot output time of the Master Unit
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 Register settings in the Master Unit

Click the Register to MU Button at the lower right of the Slave buttons registration and output 
assignment settings screen.

Slave buttons registration and output assignment settings, and one-shot output time of Master Unit 
are transferred to Master Unit.

 Save to setup file as required

Select the Save as the setup file from the File Menu as required. The configuration file is a 
tab-delimited text file format (.txt).

Note The default setup file is [Master Unit Number] _ [Master Unit Name]. If only one is entered, only the 
entered contents are displayed. If both are blank, an empty space is displayed.

The following data is written in the setup file.

• Slave buttons registration and output assignment settings

• Setting of one-shot output time of Master Unit

• Master Unit number, Master Unit name, and Slave button name

• The content of the tab delimited format is as follows.
 

Step 4 Register the settings in the Master Unit, save the setup file as 
required.

Master Unit No.

Master Unit 
name

Slave button 
No.

Slave button ID Output 1 Output 2 Output 3 Output 4 Output 5 Output 6 Output 7 Output 8
Slave button 
name

1 ID:

2 ID:

3 ID:

4 ID:

5 ID:

6 ID:

7 ID:

8 ID:

Output ON time ms
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 How to open the setup file

You can open the setup file in Microsoft Excel in the following way.

1 Start Microsoft Excel and select Open from the File Menu.

2 In File type Dialog Box, select All files (*. *), Select the setup file and click the Open Button.

The setup file is loaded in Microsoft Excel.

Additional Information

• Direct Editing of Setup Files

When installing the Wireless Switch Support Tool, the default setup file is installed in the fol-
lowing storage location.

• Storage location: C:\OMRON\Wireless Switch Support Tool\DATA

• File name: WirelessSwitchSupportTool_SettingFile_jp.txt Or
WirelessSwitchSupportTool_SettingFile_en.txt

(The file name will be changed according to the language selected during installation.)

You can easily create multiple setup files by copying this default setting file and editing it 
with Microsoft Excel, text editor.

The created setup file can be read by selecting Reading the setup file from the File Menu.

Details of the default setting file are as follows.
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6-1 Confirm the operating environment 
of the Master Unit

 

We will investigate the radio field strength around the Master Unit.

Click Others Button on the startup screen and click Noise check of the set frequency Button below.

The following Wireless communications environment confirmation screen is displayed.

Click the Start Button in the Start measuring Field.

Approximately 60 seconds later, the value of the radio field strength around the Master Unit will be dis-
played in the Result Field as the value of the received strength (RSSI: Received Signal Strength Indica-
tor). The unit is dBm.

• PK: peak of reception strength

• AV: average value of reception strength

At the same time, the following message will be displayed below it.

• The noise that may affect the communication was not found.

• The noise that may affect the communication was temporarily found.

• The noise that may affect the communication was regularly found.

Step 1 Investigation of radio field strength around Master Unit (ED scan)

Procedure
Master Unit settings

Procedure 1.
Setup of this tool

Step 1
Investigation of radio field 
strength around 
Master Unit (ED scan)

Step 2
Wireless 
communications test

2. Procedure3.
Confirmation and monitoring 
of the Master Unit status

Procedure4.
Maintenance operation
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Precautions for Correct Use

If you operate the mode settings switch of the actual Master Unit while measuring the noise 
from the Wireless Switch Support Tool, a communications error occurs.

 

Run Wireless Test * 1.

*1. Even if you receive an operation signal from the Slave button at this time, output from the Master Unit will not 
be performed.

Click Wireless test Button on the following Startup screen.

The Wireless Test screen appears.

Click the Start Button. Until you click the Complete Button, it will be additionally displayed each time 
the reception result from the Slave button is received.

Step 2 Wireless communications test
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• Display of reception result from Slave buttons:

Up to 100 logs are displayed. Next, click the Start Button to clear the display.

• Save tab-delimited text file of reception result from Slave buttons

The log of the reception result from clicking the Start Button to clicking the Complete Button is tab 
division. It is saved as a cut text file (.txt).

The file name will be the date and time seconds automatically clicking the Start Button.

Precautions for Correct Use

• If you operate the mode settings switch of the actual Master Unit while executing the wireless 
test from the Wireless Switch Support Tool, a communications error occurs. Then the follow-
ing confirmation screen as to  whether or not to continue the operation will be displayed, as 
the mode change was detected.

• Do not open a tab-delimited text file (.txt) of the reception result log until you click the Start 
Button and click the Complete Button. If you open it, you cannot write the result to a file 
when receiving data, so you cannot implement Wireless Test correctly.

• The wireless test checks the Master Unit periodically for the latest received data from the 
Wireless Switch Support Tool and displays the latest received data from the Slave button if it 
is available. However, if the Master Unit receives the operation result of the Slave button at 
intervals shorter than the interval to be periodically acquired, the value is overwritten before 
the Wireless Switch Support Tool retrieves the reception result. As a result, be aware that the 
reception result from the Slave button may be missed.
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7-1 Maintenance operation

 

Check the operating mode of Master Unit.

Click the Confirm the status Button on Set Master Unit and confirm screen from the Startup screen.

The following confirm the status screen will be displayed.

 

 

You can check the operating time of Master Unit.

Click the Confirm the status Button on Set Master Unit and confirm screen from the Startup screen. 
The following confirm the status screen will be displayed.

Confirm operating mode

Confirm operating time

Procedure
Master Unit settings

Procedure 1.
Setup of this tool

• Confirm operating mode
• Confirm operating time
• Software reset of Master Unit
• Reset the Master Unit to 

factory default

2. Procedure3.
Confirmation and monitoring 
of the Master Unit status

Procedure 4.
Maintenance 
operation
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Master Unit will return the operating mode of Master Unit to the front mode settings switch state.

Click Others Button on the Startup screen and click Software reset Button below.

The operating mode of the Master Unit is reset to the front mode settings switch state.
 

 

 

Reset the Master Unit to factory default. Operation is possible only when the Master Unit error LED is lit 
red.

Click Others on the Startup screen and click the following Reset to the factory setting (only when 
error LED is lit) Button.

Slave buttons registration and output assignment settings and one-shot output time of Master Unit are 
reset to factory default.

When the factory default reset is completed, please perform Slave button registration and output 
assignment settings again.

 

 

Software reset of Master Unit

Resetting Master Unit to Factory Default
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8-1 Troubleshooting

 

Problems Cause Countermeasures

"OMRON · · ·" is not dis-
played on the serial port 
selection screen

The cable is not correctly con-
nected to the computer.

Correctly connect again. 

The driver for the USB - Serial 
Conversion Cable is not installed.

Install the driver.
For details, refer to Section 4 Setup of this tool.

Failure to connect with 
Master Unit.

The Master Unit is not powered 
on.

Correctly connect again. 

The cable is not connected to the 
Master Unit, computer correctly.

Correctly connect again. 

Received SB ID is not dis-
played.

Display the received SB ID Check 
Box is not selected.

Select the Display the received SB ID Check Box.
For details, refer to Step 3 Slave button registration and 
output assignment settings on page 5-3 in Section 5 Mas-
ter Unit Settings.

Antenna is not properly con-
nected

Connect the antenna without loosening.

Noise check of the set fre-
quency is not displayed.

Start Button is not clicked.

Click the Start Button.
For details, refer to Step 1 Investigation of radio field 
strength around Master Unit (ED scan) on page 6-2 in Sec-
tion 6 Confirm the operating environment of the Master 
Unit.

Wireless Test result is not 
displayed.

Start Button is not clicked.

Click the Start Button.
For details, refer to Step 2 Wireless communications test 
on page 6-3 in Section 6 Confirm the operating environ-
ment of the Master Unit.

The ID of the Slave button used 
for Master Unit is not registered.

Register the ID of the Slave button to be used in the Mas-
ter Unit.
For details, refer to Step 3 Slave button registration and 
output assignment settings on page 5-3 in Section 5 Mas-
ter Unit Settings.

Antenna is not properly con-
nected

Connect the antenna without loosening.

Tab-delimited text files are 
hard to read

You have not opened it in Micro-
soft Excel.

Open it in Microsoft Excel.
For details, refer to Step 4 Register the settings in the Mas-
ter Unit, save the setup file as required. on page 5-9 in 
Section 5 Master Unit Settings.
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